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Produmex Scan Complete Configuration
Guide

It is recommended to avoid the asterisk (*), pipe (|) and apostrophe (’) characters in Produmex or
SBO master data because these characters have a special role in Produmex products.

1. Configure Produmex Scan

When starting Produmex Scan for the first time on your device, the Configuration screen will open up.
To change the configuration after the first use, run the Configure Produmex Scan application.

1.1. General tab

On the ‘General’ tab determine the connection settings and the language of the application.

Add the Server URL of the server where the client application will connect. The server URL consist●

the IP address of the server where the Service Broker runs and the port number. The port number is
50231 by default. Press the ‘…’ button to scan for servers.
After the Server URL has been added, the active databases assigned to the Service Broker are listed●

on the box. Select the company database from the list. If the application cannot connect to the
server, an error message is shown.
Select the language of the client application from the Language dropdown menu.●

Press the ‘ID’ button to see the device ID.●
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1.2. Advanced tab

Go to the ‘Advanced’ tab for further configurations.

If you would not like to use the built-in operating system default control buttons, check the ‘Do not●

use built-in OS buttons’ checkbox. It is recommended to disable the built-in buttons on Windows CE,
in desktop mode or when using remote desktop connection.
For customization purposes the Customization Assist Mode can be enabled by ticking the checkbox.●

For more information about customization please see: Produmex Scan Customization Guide
Select a Windows layout from the dropdown menu. Possible values:●

Normal: recommended in desktop mode❍

Maximized Borderless: recommended in Windows CE❍

Desktop Fullscreen: recommended when using remote desktop connection❍

Tester Mode: The tester mode is for internal testing purposes only. Do not check this box.●

1.3. Diagnostics tab

On the ‘Diagnostics’ tab network and process performance diagnostic tests can be ran.

http://wiki.produmex.name/doku.php?id=implementation:scan:customizationguide
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Press the ‘Ok’ button to apply the configurations.

2. Setting Up the Master Data in the Produmex Scan

To be able to use the mobile application you have to set up the master data in the Produmex Scan
add-on.
First set up the employees who can use the mobile application and determine their rights for the
specific mobile functions.
In order to print labels from the mobile application, configure the printers and set up the label layouts
you would like to use.

2.1. Printing

2.1.1. Defining the Layouts

You can define the layouts at Administration>Setup>Inventory>Produmex Scan>Printing Layout Sets.
On the Printing Layout Sets form you can define which layout files should be used for the specific
labels at printing.

The Description is the label name displayed on the mobile device.●

On the Bin Code Layout File field add the report file of the label version for bin locations.●

On the Stock Normal Label Layout File field add the report file of the label version for stock that is●

not managed by batches or serials.
On the Stock Batch Label Layout field add the report file of the label version for stock that is●

managed by batches.
On the Stock Serial Label Layout File field add the report file of the label version for stock that is●

managed by serial numbers.
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Define the path to the report files at the Report Layout Folder setting on the Reports tab of Produmex
Scan settings. It is recommended to use a network folder.
It is also possible to define an output folder for reports at the Report Output Folder setting on the
Reports tab of Produmex Scan settings.

2.1.2. Layout formats

2.1.2.1. Crystal Reports

Regular Crystal Reports RPT files which can contain one or more of the documented parameters. The
report can connect to and read from the database. The database logon parameters (username,
password, server, company name) are set by Warehouse before executing the report.

You can download example report files from here: Label examples
Copy the reports to the Report Layout Folder set on Produmex Scan settings. Open the reports and
adjust the datasource location.

Bin Code Layout
Crystal report file is run once with the mask as the parameter.

Parameters:
BinCodeMask – Bin code mask with *
eg. 01-A-1-1*

Stock Normal Label, Batch Label, Serial Label Layout

Parameters:
ItemCode
BatchNumber
SerialNumber
Quantity

http://builds.produmex.name/Utils/CR_LabelExamples.ZIP
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2.1.2.2. Zebra ZPL

Zebra ZPL files (or CPCL files) are text files which can contain one or more Placeholder strings.
The placeholders will be replaced by Produmex Scan before it is sent to the (networked TCP/IP or local
printer on the server) Zebra printer.

Here is a sample Stock Label ZPL file (text file). This sample file contains the following placeholders:

{Quantity}●

{OITM.InvtryUom}●

{OITM.ItemCode}●

{OITM.ItemName}●

^XA
^PW632
^LL0472

^CWD,E:ARI000.FNT

^CFD,24
^FT434,270^FDItem;^FS

^CFO,24^BY3,3,95^FT135,170^BCN,,Y,N
^FD{Quantity}{OITM.InvtryUom}^FS
^FT492,270^FD{OITM.ItemCode}{OITM.ItemName}^FS
^PQ1,0,1,Y^XZ

Bin Code Layout
ZPL file is printed for every bin location found for the given mask.

Placeholders:
{OBIN.BarCode}
{OBIN.BinCode}
…
(Every field including user fields are available from OBIN table, reference it with the database column
names)

Stock Normal Label, Batch Label, Serial Label Layout
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Placeholders:
{ {OOIITTMM..IItteemmCNaodmee} }
{OITM….}
…
{Quantity}
{OBTN.BatchNumber}
{OBTN.CreationDate}
{OBTN….}
…
{OSRN.MnfSerial}
{OSRN.DistNumber}
{OSRN….} ….
Every field (including user fields) available from OITM table
For batches only: every field (including user fields) available from OBTN table
For serials only: every field (including user fields) available from OSRN table

2.1.3. Setting Up the Printers

You can set up the printers at Administration>Setup>Inventory>Produmex Scan>Printers Setup. Both
local and network printers can be configured.

In order to configure a local printer, make sure that the ‘Is Network Printer’ checkbox is not checked.●

Enter the name of the printer to the Local Printer Name field.
In order to configure a network printer, check the ‘Is Network Printer’ checkbox. Add the IP Address●

as the IP Address and the port as the Port Number.

Indicate whether the printer is active or not with the ‘Is Active’ flag. Only active printers can be
selected on the mobile application.

Select the type of the printer from the Printer Type dropdown menu. The following printer types are
supported:

Crystal●

Zebra CPCL●

Zebra ZPL●



2019/03/13 12:10 7/31 Produmex Scan Complete Configuration Guide

- http://wiki.produmex.name/

It is possible to assign layouts that can be used with the printer. Select the line of the printer then
choose the Select Layouts option from the right-click menu.

On the opening form select the layout(s) from the dropdown menu on the Layout Set Code field. With
the Visual Order it is possible to determine the order of the layouts on the list.

Default printer properties
The printing is processed via the Produmex Service Broker. By default Produmex Service Broker
runs in a context of the LocalSystem account therefore it takes its printing settings from the
default properties. Meanwhile, Crystal Reports takes its printing settings from the user-specific
properties.
In order to change the printing settings for Produmex Scan, change the user specific and the
default printing properties as well.
To change the user specific settings, open ’Printing preferences’ of the printer. You can change
the user specifc setting on the ’Options’ tab.
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To change the default properties, select the ’Printing Properties’ option. On the opening screen
go to the ’Advanced’ tab and click on the ’Printing Defaults’ button to change the default printing
preferences.

2.2. Setting Up Employees

The user specific settings for Produmex Scan users can be configured on the Employee Master Data.
The following settings can be configured:

User authorization●
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User password●

Favorite menus●

Printers●

2.2.1. Authorization fields

To authorize a functionality for the employee, set the corresponding UDF to ‘Yes’. The employee will
only see the authorized functions on the main menu of the client application.

The ‘Query stocks’ function is authorized for every employee by default. It does not have an
authorization UDF.

2.2.2. Default Printer

On the Default printer UDF the printer used in customization can be defined. This printer will only be
used in customization, it will not be listed among the printers defined for the user.

2.2.3. User password

Set the user password on the Mobile Password UDF.

http://wiki.produmex.name/lib/exe/detail.php?id=implementation%3Ascan%3Acompleteconfguide&media=implementation:scan:setup:emd_userfields.png
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2.2.4. PIN Code

By default the user can login with the Employee No.. If there is a PIN code set, it is possible to log in
with the PIN code as well.

2.2.5. Mobile User Preferences

To configure the favorite menus for a user, select the ‘Mobile User Preferences’ option from the right-
click menu or click on the ‘Mobile User Preferences’ button on the ‘Administration’ tab.
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The ‘Mobile User Preferences’ form will open up. On the header of the form the Employee ID and the
Employee Name are shown.

Select a menu point from the dropdown list on the ‘Mobile Menu ID’ column then define the sequence
of the menu buttons on the ‘Visual Order’ column. Menu points with the smallest visual order number
will be shown first.

Click on the ‘Update’ button to apply the changes.
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The favorite menu buttons will be displayed on the top of the main menu of Produmex Scan.

2.2.6. Mobile User Printer

On the Employee Master Data select the ‘Mobile User Printers’ option from the right-click menu or
click on the ‘Mobile User Printers’ button on the ‘Administration’ form.
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The ‘Mobile User Printers’ form will open up. On the header of the form the Employee ID and the
Employee Name are displayed.

Select the printer from the dropdown menu. Every printer defined on the Printers table is listed.

Add the sequence of the printer on the visual order column.
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The printer with the lowest ‘Visual Order’ value will be shown as the default printer on the Login
screen or before printing. It is possible to change the default printer. Press the ‘…’ button then select
a printer from the list. Every printer defined for the user on the ‘Mobile User Printers’ form will be
listed. The order of the list depends on the ‘Visual Order’ value.

3. Produmex Scan Settings

Settings for the system can be found in the add-on, under Administration>Add-Ons>Produmex
Scan>Produmex Scan Settings.
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3.1. General tab

The following table describes the fields that appear in the 'General' tab of the Produmex Scan Settings
window.

Field Description/Activity
Don't translate trace Obsolete setting.

Advanced Progress Bar
If this checkbox is checked, the system will display the Produmex Scan
Advanced Progress Bar instead of the Business One Progress Bar. We
recommend using the Produmex Scan progress bar, as at long processes
SBO progress bar can stop.

DisplayTimeUoM This setting is not in use in Produmex Scan.
Company Logo The company's own logo, used in reports. Path to image file requested.
BxBackOffice Server URL Obsolete setting.
Chart XML Folder This setting is not in use in Produmex Scan.

Produmex Support
Business Partner

If an error occurs, a message box is displayed with the error details. You
can send the error message to Support from this message box. You will
need to set a Business Partner first, and set the Contact Person's email
address. Set this Contact Person's code for the Produmex Support
Business Partner field. You have to set up SBO Mailer for this function to
work.

Name of last started AddOn Internal field, not editable.
Date of last started AddOn Internal field, not editable.
Time of last started AddOn Internal field, not editable.

Use Message Board
The message board lets add-ons communicate with each other. In some
cases, events are forwarded to non-Produmex add-ons. In this case, turn
this setting off, but in this case communication between Produmex add-
ons will stop.

TxSyncServer URL This setting is not in use in Produmex Scan.
Seconds of last started
AddOn Internal field, not editable.

Grid Row Count Decrease
Number

Decrease height of form grid to allow buttons being correctly seen at the
bottom of the window. Positive integer needed. Useful if you have SAP
8.8 or higher with a low resolution monitor and the buttons are in the
grids.

Close Stucked AddOns
If enabled, the add-on kills any other instance of BXWH9AddOn.exe on
start. It means that only one Produmex Scan add-on can run at a time.
On terminal server environments it is recommended to disable this
setting as it kills Produmex Scan add-ons run by other users as well.

Enabe Produmex statusbar
(SBO 8.8 or above) Obsolete setting

Do Not Use GetAsXml
When Produmex Scan request table information, we can use GetAsXml
SAP function. Sometimes there were SAP DI errors, in this case we can
use a Produmex Scan function to request the data.

Password for DI Connection Modify DI connection mode to work around for SAP 9.0 pl9 hotfix 1 bug
by direct DI connection

Copy Bitmaps Manually
If enabled, the icon image files will not be copied from the SBO
installation folder when the add-on starts. Enable this setting if the user
do not have writing permission for the folder set as the Pictures Folder
on the Path tab of General Settings.
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3.2. SQL tab

The following table describes the fields that appear in the 'SQL' tab of the Produmex Scan Settings
window.

Field Description/Activity

ADO.NET SQL Username The User name for the MS SQL database (usually sa). Scripts use this
setting (for example for upgrading a database).

SQL Time out in seconds SQL Timeout setting for SQL queries.
SQL execution duration alert
in milliseconds

If the execution of a query exceeds the time defined in this setting, a
warning is added to the log file.

3.3. Logs tab

The following table describes the fields that appear in the 'Logs' tab of the Produmex Scan Settings
window.

Field Description/Activity

Auto Purge Audit
Logs in days

The add-on logs each database transaction in the Audit Log table. This log can
be deleted automatically in the interval set here. The default setting is 30
days.

Keep Audit Logs in
days

The system deletes the log entries, which are older than the number of days
set here.

Log resource strings
If this checkbox is checked, the system logs every Resource String from open
forms to a log file. By default log files are located in:
%AppData%\Roaming\BX\Logs.

Logging Level

Sets which events are logged. Possible values:
Errors Only
Errors and Warnings
Errors, Warnings, Information
Debug (everything)
By default log files are located in: %AppData%\Roaming\BX\Logs.

Log Table - max
number of days to
keep

Log entries that exceed the specified number of days will be deleted from the
“@BXPLOG” table.

Log Table - max
number of rows to
keep

Defines the maximum number of rows that are kept in the “@BXPLOG” table.

3.4. Reports tab

The following table describes the fields that appear in the 'Reports' tab of the Produmex Scan Settings
window.

Field Description/Activity
Report Layout Folder The folder which contains the RPT files for reports.
Report Output Folder The folder which will contain the generated PDF files for reports.
Paper Size (Reports) Paper size for reports. Example: A4, A3
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Field Description/Activity
Paper Orientation (Reports) Paper orientation for reports. Example: portrait, landscape
Printer Name (Reports) Printer name for reports.

Print Preview (Reports) If enabled, the Preview before print checkbox is checked by default on
the Select Report Layout screen.

Preview with Watermark If enabled, the watermark is printed on print previews as well.

3.5. Produmex Scan General

The following table describes the fields that appear in the 'Produmex Scan General' tab of the
Produmex Scan Settings window.

Field Description/Activity

Maximum number of
documents to display per page
(more than 20 may cause
performance issues)

Defines the maximum number of lines displayed on one screen. If the
number of the lines to be listed exceeds this number, page navigator
buttons are displayed on the screen. Use these buttons to navigate
between pages.
Please note: The Refresh button must be pressed in order to apply
the added filters even though the navigation buttons are displayed.

Maximum number of
serials/batches to display
(more than 100 may cause
performance issues)

If you work with serial/batches numbers, with this setting you can
limit the number of the displayed items.

Maximum number of lines for
stock queries to display (more
than 100 may cause
performance issues)

Defines the maximum number of lines displayed in the Query
Stocks/Stock Info screens.

Don't close screens with
completed quantity

If you picked all quantities on quantity screens, then Produmex Scan
falls back to the document line screen by default. In this case you
cannot use any customization after a ’ButtonAdd’ event. With this
setting you can configure Produmex Scan to stay on the quantity
screens, and you have to close it manually.

Don't close screen after
picking delivery

After the delivery is created in Picking, Produmex Scan falls back to
the select a pick list screen by default. If this checkbox is enabled,
Produmex Scan stays on the pick list lines screen after the delivery is
created.

Allow issuing more items for
production than planned

If this setting is disabled, only the production order lines that have
open quantities to issue are listed in the ’Issue for production’
function.

Allow reception of more
products than planned

If this setting is disabled, only production orders that have open
quantities to receive are listed in the ’Receipt form Production’ and
’By-Product’ functions.
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Field Description/Activity

Enable multi-item Stock
Transfers

This function allows to park transactions before you post them, that
is, you can add multiple items to a stock transfer before posting.
Once you click the Post button, however, it is possible that not only
your transactions will be posted. If there is another user creating
a stock transfer to the same warehouse/bin location, the
user’s transactions will be posted as well.
(If you are supposed to be allowed to post only your own
transactions, please consult with the description of function
Transaction Separation for Warehouse Scanners available in this
table.)
If function Enable multi-item Stock Transfers is disabled, only single-
scan-transactions are possible, that is, you are allowed to post
transactions only one by one.

Ignore special lines when
creating Documents

It is enable, the text lines of a sales order won’t be copied to a
delivery.

Exclude Sales Orders when
checking allocated quantities

If enabled, stock allocated to sales orders cannot be used when
issuing stock during outgoing processes.

Sales return document location
must be the same Items can only be returned to the same bin location.

Credit note document location
must be the same Items can only be returned to the same bin location.

Keep base document line order
for Delivery (instead of picking
order)

If enabled, the Delivery document lines are added in the order of the
base document, otherwise they will be added in the order of the
picking.

Real-time Stock Counting

If enabled, Produmex Scan automatically updates the Inventory
Counting document with the result of the counting after pressing the
Finish button in the end of Stock counting or Quick counting.
If this setting is disabled, the counting result will be stored in a user
table.

Show all Stock Counting data
on scanners

If enabled, already counted items are listed on the Stock Counting
screen. Please note: Items with different batch or serial number will
be listed in separate lines.
If disabled, only the number of the counting records is displayed.

Display all sheet bin locations
for Quick Counting It is enable all bin location will be displayed for quick counting.

Guided Quick Counting (Y/N) If enabled, the Guided Count process can be started instead of Quick
Counting.

Restricted zone handling in
Quick Counting (Y/N)

If enabled, the counter is only allowed to count locations included in
the Inventory Counting document during Quick Counting and Guided
Counting.

Sticky destination location for
Stock Transfer Requests

If enabled, the last To: location will be remembered during
processing Stock Transfer Request, this can be convenient if STR
items are put in the same destination location (maybe a cart, pallet,
etc.)

Keep focus on prepared line
(all processes)

If enabled, the last To: location will be remembered during
processing Stock Transfer Request, this can be convenient if STR
items are put in the same destination location (maybe a cart, pallet,
etc.)

Display completed Stock
Transfer Request lines at the
end of the list

At Stock Transfer Request process the processed lines will be shown
in the bottom of the list.
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Field Description/Activity
Goods Receipt PO quick
refresh mode

During reception, Goods Receipt PO lines can be set to refresh data
only on the current line, not the whole list.

Copy user fields from base line
to Serial/Batch Details (Goods
Receipt PO only)

Enable this setting to copy the UDF value from the purchase order
lines to the matching Serial/Batch detail field when the Goods Receipt
PO is created.
Please note: The value will be copied only if the UDF and the
Serial/Batch detail has the exact same name.

Timeout for messages (except
for errors, seconds)

Warnings, Information messages, are closed automatically after the
time set at this field.

Diagnostic Client Log settings Special option for collecting error logs from the mobile client. Only
use when instructed by Produmex support.

Don't show icons on main
menu (use buttons instead) Display only simply buttons with no icons.

Detailed mobile log Only for picking and stock transfer. More details are recorded in to
table: @BXPLMSMOBLOG

Enable SAP DI API logging
If this setting is enabled, a new log file is created under
“C:\ProgramData\BX\BX Service Broker\Logs”. The file name is SAP-
DIAPI-yyyy-mm-dd.log

Alternative Item Name field
To display alternative item names on the scanner, add the OITM table
field name where the alternative name of the item is stored to this
field. Please note: In order to add user defined fields, insert the ‘U_’
prefix. Restart the Service Broker to apply the Alternative Item Name.

Transaction Separation for
Warehouse Scanners

Using this function is reasonable only if you enable function Enable
multi-item Stock Transfers (the description of the function is available
in this table).
If function Transaction Separation for Warehouse Scanners is
enabled, you can add multiple items to a stock transfer before
posting, however, when you click the Post button, only your
transactions will be posted.

3.6. Produmex Scan Scanning

The following table describes the fields that appear in the 'Produmex Scan Scanning' tab of the
Produmex Scan Settings window.

Field Description/Activity

Item code or item barcode must
be scanned for Sales Order

If this option is enabled, then the item code or the item’s bar code
must be scanned when delivering the sales; otherwise the item is
prefilled and doesn’t need to be scanned.

Item code or item barcode must
be scanned during Picking

If this option is enabled, then the item code or the item’s bar code
must be scanned during picking; otherwise the item is prefilled
and doesn’t need to be scanned.
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Field Description/Activity
Prefill quantities for Goods Receipt
PO

Prefill quantities (separate options for different processes):
None: No prefill will be used for this task.
Open: The system will fill in the quantities of all receives as the
full expected or full remaining expected quantity. For example: if
the order is 20 and 5 have been received, the system will default
the next receive for 15.
Unit: The system will fill in the quantities with one unit.

Prefill quantities for Stock Transfer
Request
Prefill quantities for Picking
Prefill quantities for Issue for
Production
Prefill quantities for Receipt from
Production
Prefill quantities for Return
Components

Prefill unique batches (outgoing
processes)

If this setting is enabled, an there is only one batch in stock for
the item, the batch is automatically filled during outgoing
processes.

Prefill unique batches for Stock
Counting

If this setting is enabled, an there is only one batch in stock for
the item, the batch is automatically filled during stock counting.

Post the corresponding quantity
when scanning item bar code in
quantity field

When scanning an item’s bar code into a quantity field, a quantity
of 1 for the corresponding UoM is pre-filled; if this option is
enabled, the quantity is automatically posted/added, otherwise
the user has to press the Add/Update/Post button.

Auto book unit when scanning
normal item for Stock Counting

When doing inventory counting, scanning a barcode automatically
counts a unit (eg. 1 piece, 1 carton) for the item

Barcode scanner prefix
Barcode scanner suffix

If the barcodes contain prefix/suffix characters that should be
removed before processing it, you can specify it here. Eg. if you
have a ( and ) prefix/suffix, the printed item barcode can look like
(A1000) which will be processes as A1000.

GS1-128 barcode group separator Group separator character for GS1-128 type barcodes. Example: $

Code ID type
For GS1-128, there are two international standards, the Symbol
standard and the AIM standard. With Symbol CodeID, the scanned
input text is prefixed with (K for GS1128. Currently only Symbol is
supported.

Allow selecting locations from
Find Stocks screen (outgoing
processes)

If enabled, the Find Stocks button allows to select an location.

Allow selecting batches from Find
Stocks screen (outgoing
processes)

If enabled, the Find Stocks button allows to select an existing
batch.

Optimized mixed serial/bin
handling (Goods Receipt PO,
Stock Transfer Request)

If enabled, the bin location and the serial number can be added
on the GR/PO lines screen.

3.7. Produmex Scan Picking

The following table describes the fields that appear in the 'Produmex Scan Picking' tab of the
Produmex Scan Settings window.

Field Description/Activity
Allow working on already
taken Pick Lists

It is advised for an extend pick list. More than one user is allowed to pick
the items included in the list.
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Field Description/Activity
Real-time Picking (post
instantly after picking an
item)

If enabled (default) every picking action instantly updates the SAP Pick
List document.

Allow changing
bin/batch/serial allocations
for Picking

If enabled, the bin/batch/serial numbers are allowed to be different than
what is specified in the Pick List.

Speed Picking (Real-time
Picking must be disabled)

If it is enabled, the lines from the selected picklist are loaded only once,
when the Picking screen is first opened for that pick list. The selection
automatically jumps onto the next un-picked line following the line last
picked; this is another improvement to simplify the picking process.

Sequential Picking (‘Speed
Picking’ must be enabled)

If it is enabled, the entire control stays basically in the Picking Line
Details screen, and the control jumps back to the Pick List screen only
after the last line has been picked. The user can always jump back with
the Back button, of course.

Streamlined Picking
Enables a special POS-like mode for picking where all items are picked
from a single bin location or non-bin warehouse. In this case, scanning
an item code or barcode automatically adds a quantity of 1 (can be
changed on the screen) to the picked quantity.

Pick List lines quick refresh
mode

When picking from a non-bin warehouse the Pick List - lines screen can
be set to only refresh the current line data (quantities), not the whole
list.

Release active Pick List on
timeout

During picking, the Pick List is allocated to the working employee. If
there is a timeout and the worker is forced to the main menu, if this
option is set the pick list will be reset to be available to others.

Timeout interval for Picking
(seconds)

If specified, the worker is forced to the main menu from picking after
this many seconds of inactivity.

3.8. Produmex Scan Strategies

The following table describes the fields that appear in the 'Produmex Scan Strategies' tab of the
Produmex Scan Settings window.

Field Description/Activity
Incoming strategies user query name The user query name used for the incoming strategy.
Incoming strategies frequency
(seconds)

Number of seconds to run the incoming strategy periodically.
0 = disabled.

Replenishment strategies user query
name The user query name used for the replenishment strategy.

Replenishment strategies frequency
(seconds)

Number of seconds to run the replenishment strategy
periodically. 0 = disabled.

4. How to customize Employee Master Data for Produmex
Scan with standard SBO tools

Disclaimer: This documentation describes the standard SAP Business One UI
Configuration function.
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4.1. Create a configuration template

Open the UI Configuration Template form by following the path: Administration > Utilities > UI
Configuration Template.

Go to ’Add’ mode and create a new template. On the Forms tab add the Employee Master Data. It is
possible to assign the template to selected users only on the Assigned Users tab.

We will name our template ’Produmex Scan’.

http://wiki.produmex.name/lib/exe/detail.php?id=implementation%3Ascan%3Acompleteconfguide&media=implementation:scan:custom:emd:new_template.png
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4.2. Edit the Employee Master Data UI

Select the Employee Master Data line and click on the Edit Form UI button. The Employee Master Data
form will open in UI Edit Mode.
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To add a new tab, select the Add tab option from the right-click menu.

We will add a Scan tab.

Drag the User Defined Fields and drop it on the new tab. After the field is placed on the tab, it can be
resized. To arrange the UDFs on the tab, select multiple fields and align them with a right-click menu
aligning option.



2019/03/13 12:10 25/31 Produmex Scan Complete Configuration Guide

- http://wiki.produmex.name/

It is also possible to move standard SBO fields or standard SBO buttons from other tab as well. As the
best practice, grab the button, place it on the header area, then go to the destination tab. Grab again
the button and place it on the destination tab.

Please note: The Mobile User Preference and the Mobile User Printer button cannot be moved.

5. Configure HTTPS for Produmex Service Broker with a self-
signed certificate

5.1. Produmex Service Broker Settings

Open the Produmex Service Broker configuration window from the Produmex Service Broker.

Enable HTTPS by setting the ‘HTTPS enable?’ setting to True, then set the port you would like to use
as the ‘SSL Port to listen on’.
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5.1. Create client certificate

Create the self-signed certificate on your server.

In this documentation we used MakeCert.exe which is a part of the Microsoft Windows SDK. You can
download the Windows SDK from here:

Windows 10: https://developer.microsoft.com/en-us/windows/downloads/windows-10-sdk●

Versions previous to Windows 10: https://developer.microsoft.com/en-us/windows/downloads/sdk-●

archive

Open Command Prompt as an administrator and run the following command:
<path>makecert.exe -r -pe -n “CN=<name>” -eku 1.3.6.1.5.5.7.3.1 -ss my -sr
localMachine -sky exchange -sp “Microsoft RSA SChannel Cryptographic
Provider” -sy 12 <filename>.cer

Replace <path> with the actual access path of the MakeCert.exe. Adapt the <name> and the
<filename> as well.

In this example we used the following command:
C:\Program Files\Microsoft SDKs\Windows\v7.1\Bin\makecert.exe -r -pe -n
"CN=ServiceBroker" -eku 1.3.6.1.5.5.7.3.1 -ss my -sr localMachine -sky
exchange -sp "Microsoft RSA SChannel Cryptographic Provider" -sy 12
ServiceBroker.cer

https://developer.microsoft.com/en-us/windows/downloads/windows-10-sdk
https://developer.microsoft.com/en-us/windows/downloads/sdk-archive
https://developer.microsoft.com/en-us/windows/downloads/sdk-archive
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In this documentation we used MakeCert.exe which is a part of the Microsoft Windows SDK for
Windows 7 and .NET Framework 4. Please keep in mind that other versions of MakeCert or other
certification generators might use different parameters.

5.2. Import the certificate on a Windows server

Run the Microsoft Management Console (mmc.exe). From the File menu select Add/Remove Snap-In.
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Choose the Certificates snap-in and add it to the ‘Selected snap-ins’. On the opening Certificates
snap-in select ‘Computer account’. On the next screen choose Local computer (or select the computer
account) then click on the Finish button.

On the Console navigate to Certification via Certificates (Local computer) > Trusted Root Certification
Authorities > Certification. Right-click on Certification and select Import… from All Tasks.

Follow the steps of the Certificate Import Wizard. Browse the ServiceBroker.cer, place the certificate
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to the Trusted Root Certification Authorities certificate store and finish the import.

Then import the certificate to the Personal folder as well, following the above described steps.

5.3. Bind the certificate to the port number

Bind the ServiceBroker.cer to the port number.

In this example we use the following netsh command in order to configure the certification to the port
number.

Run the following command with Command Prompt:

netsh http add sslcert ipport=0.0.0.0:port certhash=thumbprint appid={app-
guid}

Where:

ipport: is the IP address and the listening port. You can use a special IP address 0.0.0.0 that●

matches any IP address for the local machine. The listening port must be the same as the ‘SSL Port
to listed on’ that is set on the Produmex Service Broker service configuration screen.

certhash: The thumbprint of the certificate is the certificate’s SHA-1 hash, represented in●

hexadecimal. In order to determine the certhash, open the certificate and go to the Details tab.
Copy the thumbprint value to a text editor and remove all spaces between the hexadecimal
characters. Make sure that there are no hidden characters in the string. (Eg. select the line and set
the encoding to ANSI.)
appid: is the GUID (e.g. {00000000-0000-0000-0000-000000000000}) that identifies the owning●

application. The GUID of the Produmex Service Broker is {d4deb269-37e6-49db-a9cd-
cd74f52d36c3}

http://wiki.produmex.name/lib/exe/detail.php?id=implementation%3Ascan%3Acompleteconfguide&media=implementation:scan:setup:https:ssl_port.png
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Example command:
netsh http add sslcert ipport=0.0.0.0:50232
certhash=a828d05b70e88c9c904fe5149ad170ff89433102 appid={d4deb269-37e6-
49db-a9cd-cd74f52d36c3}

5.4. Import the certificate

Besides the server, the certificate has to be imported on every computer that connects to Produmex
Service Broker over HTTPS.

5.4.1. Import the certificate on a mobile device

In this example we installed the certificate on a Honeywell Dolphin 60 device with Windows
Embedded Handheld 6.5 Classic operating system. The installation steps may differ based on the
operating system and the device.

Copy the certificate file to the device, eg. to the My Documents folder.

Open the File Explorer from Start>Programs>File Explorer and open the folder where you copied the
certificate. Tap on the certificate file you would like to import.

A ‘Certificate Installation’ message opens up. Press the ‘More’ button. To see the details of the
certificate file, tap on the ‘requester’ link. To install the certificate, press the ‘Install’ button.

http://wiki.produmex.name/lib/exe/detail.php?id=implementation%3Ascan%3Acompleteconfguide&media=implementation:scan:setup:https:cmd_02.png
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If the installation is successful, a confirmation message is displayed. The certificate is imported to the
Root folder of Certificates.
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